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1 Important

Safety

Information for Europe:

Know these safety symbols

CAUTION
RISK OF ELECTRIC SHOCK
DO NOT OPEN

(CAUTION: TO REDUCE THE RISK OF ELECTRIC SHOCK, DO NOT
REMOVE COVER (OR BACK). NO USER-SERVICEABLE PARTS
INSIDE. REFER SERVICING TO QUALIFIED SERVICE PERSONNEL.

A A

The ‘exclamation mark’ calls attention to
features for which you should carefully read the
supplied literature to prevent operating and
maintenance problems.

The 'lightening bolt’ symbol indicates uninsulated
components within the product that can cause
an electric shock.

To reduce the risk of fire or electric shock, do
not expose the product to rain or moisture and
do not place any objects filled with liquids, such
as vases, on the product.

Read these instructions.

Keep these instructions.

Heed all warnings.

Follow all instructions.

Do not use this product near water.

Clean only with dry cloth.

WEO®EOEE

Do not block any ventilation openings.
Install in accordance with the
manufacturer’s instructions.

o~

EN

Do not remove the casing of this product.

@ Do not expose the product to dripping /
splashing water, rain or high humidity.

Keep this product away from direct
sunlight, naked flames or heat.

@ Do not install near any heat sources
such as radiators, heat registers, stoves,
or other electrical equipment (including
amplifiers).

Do not place any other electrical
equipment on the product.

Do not place any sources of danger
on the product (e.g. objects containing
liquids, burning candles).

® ©® ©

This product may include batteries. Please
refer to safety and disposal instructions
for batteries in this user manual.

©)

Where the mains plug or an appliance
coupler is used as the disconnect device,
the disconnect device shall remain readily
operable.

1N Warning

* Never remove the casing of this apparatus.

* Never lubricate any part of this apparatus.

* Never place this apparatus on other electrical
equipment.

* Keep this apparatus away from direct sunlight, naked
flames or heat.

* Ensure that you always have easy access to the power
cord, plug or adaptor to disconnect this apparatus from
the power.

Risk of overheating! Never install this apparatus
in a confined space. Always leave a space of

at least four inches around this apparatus for
ventilation. Ensure curtains or other objects
never cover the ventilation slots on this
apparatus.



Mains fuse

This information applies only to products with a
UK mains plug.

This product is fitted with an approved molded
plug. If you replace the fuse, use one with:

*  the ratings shown on the plug,

* aBS 1362 approval, and

*  the ASTA approval mark.

Contact your dealer if you are not sure about
what type of fuse to use.

Caution: To conform with the EMC directive
(2004/108/EC), do not detach the plug from
the power cord.

Notice

q

This product complies with the radio
interference requirements of the European
Community.

C€ 0560 (1) RaTTE Directive 1999I5/EC

BG VRO vV [BE VLT /U /]IS V/]SE /|
bk VIES V[cz /INL /[AT /v V/[sK /
FR VUK V[FI_VIPT /ey /ImT /Pl /|
HU VINO V [GR /[sI VI[EE V/
T /LU V[IE /[cH VDE V/

The device can be operated in the EU without
restrictions indoor, but cannot be operated
outdoors in France in the whole of the band
until further notice.

This product complies with the requirement of
the 1999/5/EC directive.

Modifications

Modifications not authorized by the
manufacturer may void user's authority to
operate this product.

&5

Your product is designed and manufactured
with high quality materials and components,
which can be recycled and reused.

)i

When this crossed-out wheeled bin symbol is
attached to a product it means that the product
is covered by the European Directive 2002/96/
EC.

Please inform yourself about the local separate
collection system for electrical and electronic
products.

Please act according to your local rules and

do not dispose of your old products with your
normal household waste. Correct disposal of
your old product helps to prevent potential
negative consequences for the environment and
human health.

)54

Your product contains batteries covered by
the European Directive 2006/66/EC, which
cannot be disposed with normal household
waste.Please inform yourself about the local
rules on separate collection of batteries
because correct disposal helps to prevent
negative consequences for the environmental
and human heatth.
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Information about the use of batteries:

n Caution

* Risk of leakage: Only use the specified type of batteries.
Do not mix new and used batteries. Do not mix
different brands of batteries. Observe correct polarity.
Remove batteries from products that are not in use for
a longer period of time. Store batteries in a dry place.

* Risk of injury:Wear gloves when handling leaking
batteries. Keep batteries out of reach of children and
pets.

* Risk of explosion: Do not short circuit batteries. Do
not expose batteries to excessive heat. Do not throw
batteries into the fire. Do not damage or disassemble
batteries. Do not recharge non-rechargeable batteries.

Environmental information

All unnecessary packaging has been omitted.
We have tried to make the packaging easy to
separate into three materials: cardboard (box),
polystyrene foam (buffer) and polyethylene
(bags, protective foam sheet.)

Your system consists of materials which can

be recycled and reused if disassembled by

a specialized company. Please observe the

local regulations regarding the disposal of
packaging materials, exhausted batteries and old
equipment.

( Made for

\ GiPod [JiPhone [JiPad
[al

AirPlay

“Made for iPod,”“"Made for iPhone,” and “Made
for iPad” mean that an electronic accessory
has been designed to connect specifically to
iPod, iPhone, or iPad, respectively, and has
been certified by the developer to meet
Apple performance standards. Apple is not
responsible for the operation of this device

or its compliance with safety and regulatory
standards. Please note that the use of this
accessory with iPod, iPhone, or iPad may affect
wireless performance.

AirPlay, iPod, and iPhone are trademarks of
Apple Inc, registered in the U.S. and other
countries. iPad is a trademark of Apple Inc.

Class Il equipment symbol:

=

CLASS Il apparatus with double insulation, and
no protective earth provided.

Note

* The type plate is located on the bottom of the
apparatus.




2 Your
Entertainment
System

Congratulations on your purchase, and
welcome to Philips! To fully benefit from the
support that Philips offers, register your product
at www.philips.com/welcome.

If you contact Philips, you will be asked for the
model and serial number of this apparatus. The
model number and serial number are on the
bottom of the apparatus. Write the numbers
here:

Model No.

Serial No.

Introduction

Apple AirPlay technology enables you to play
your iTunes music library, hosted on a Mac, PC,
iPhone, iPod touch, or iPad on any AirPlay-
enabled device (for example, your AD7000W)
connected to the Wi-Fi network.

With an AirPlay-enabled device (for example,
your AD7000W) you can:
stream audio from your iTunes music
library to any room in your house
*  choose which AirPlay-enabled devices
you want to play music on (if you
have more than one such devices in
your house)
*  stream audio to multiple AirPlay-
enabled devices at the same time
(from the iTunes music library on your
PC/Mac only)

3

* Please visit www.philips.com/welcome for information
about more Philips AirPlay-enabled devices.

With AD7000VV, you can also:

*  charge your iPod/iPhone/iPad through
the USB socket with an Apple USB
cable (not supplied).

*  play your iTunes music library on your
iPod/iPhone/iPad through the USB
socket directly while charging.

*  play music from other audio devices
through the MP3-LINK socket.

What’s in the box

Check and identify the contents of your
package:

* Main unit (with a built-in Wi-Fi

module)

* 1 xAC power adapter

* 1xMP3link cable

*  User manual (in CD-ROM)

*  Quick start guide

What else you need

To stream audio wirelessly by AirPlay, you need:
*  AWi-Fi certified router
* A host for your iTunes music library,
for example, an iPod touch/iPhone/
iPad installed with iOS 4.3 (or later)
or a Wi-Fi enabled PC/Mac installed
with iTunes 10 (or later)

Your AD7000W should be connected to the
same local network as your iTunes host device
through the Wi-Fi routen.
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List of compatible iTunes host devices
for AirPlay

In terms of AirPlay, AD7000WV is compatible

with:

*  aWi-Fi enabled PC/Mac installed with
iTunes 10 (or later); and

*  the following iPod/iPhone/iPad models
installed with iOS 4.3 (or later):

e Pad?2

e iPad

e iPhone 4

e  iPhone 3GS

*  iPod touch (2nd, 3rd, and 4th
generation)

Overview of the main unit

OXC)

©®

@ Power indicator

@) +-

*  Adjust volume.
® o
*  Turn the unit on/off.
e (Press and hold) reset the unit.

(4) WI-FI SETUP button/indicator
e Connect the unit to a Wi-Fi network.
*  Show the Wi-Fi connection status of
the unit.

(5) MP3-LINK
*  Connect an external audio player
through the supplied MP3 link cable.

(&) DCIN

»  Connect the power adaptor.

(@) USB+<-
»  Connect an iPod/iPhone/iPad through
an Apple USB cable (not supplied).

Get started to use AirPlay

To get started with AirPlay, you need to:

1 Upgrade your iPod touch/iPhone/iPad to
the latest iOS version (iOS 4.3 or later).
*  Orinstall the latest version of iTunes
(iTunes 10 or later) on vour PC/Mac.

2 Connect power to AD7000W, then turn it
on (see 'Prepare’ on page 7).

3 Connect AD7000W to your existing home
Wi-Fi network (see ‘Connect to your
home Wi-Fi network for AirPlay’ on page
1C).

4 Make sure that your iPod touch/iPhone/

iPad or PC/Mac are also connected to the
same Wi-Fi network.



3 Prepare Turn AD7000WV on

1 Press O on the back to turn the unit on.

) o } 2 Wait for successful boot-up of the unit.
Always follow the instructions in this chapter in » The boot-up takes about 35 seconds.

sequence. ) o
% During boot-up, the Wi-Fi SETUP
indicator on the back of the unit blinks
green quickly.
> After boot-up, if no Wi-Fi connection

Connect power

n Cauti has been set up for AD7000WV, the
aution Wi-Fi SETUP indicator starts to blink
* Risk of product damage! Make sure that the power green S|OW|)/.

supply voltage matches the voltage printed on the

bottom of the unit. *  To switch the unit to Eco standby mode,

* Risk of electric shock! When you unplug the AC press O again.
adaptor, always pull the plug from the socket. Never . To switch the unit on from Eco standby
pull the cord.

, .
* Before you connect the AC adaptor, make sure that you mode, press O again.

have completed all the other connections.

\

(@i GO |

)
A8

*  Connect the AC power cord to
» the DCIN socket on the back of the
unit.
*  the wall power socket.
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4 Connect to
your home Wi-

Fi network for
AirPlay

To connect AD7000W to your existing home
Wi-Fi network, you need to apply your home
Wi-Fi settings to AD7000WV.

You can do this in two ways (depending on
which type of Wi-Fi router you use):

e Automatically - if your Wi-Fi router
sWPS (Wi-Fi Protected Setup)-
=nabled and supports PBC (Push
3utton Connection) (see ‘Scenario 1:
Connect to a WPS router’ on page
1C)

*  Manually - if your Wi-Fi router does
1ot support WPS (see ‘Scenario 2:
Connect to a non-WPS router’ on
page 11)

Once connected successfully, AD7000W will
remember your home Wi-Fi settings. Then

you can enjoy AirPlay whenever AD7000WV is
powered on and connected to your home Wi-
Fi network automatically.

10 EN

Before connection of AD7000VV to you home
Wi-Fi network, check the points below.

1 Make sure that your Wi-Fi router is
nowered on and working properly.

2 Make sure that AD7000W has been
cowered on and booted up successfully
(see Turn AD7000WV on' on page 7).
Identify the type of your Wi-Fi router (see

the user manual of your Wi-Fi router for
details).

w

Scenario 1: Connect to a
WPS router

* Before you press any button on AD7000W, make sure
that AD7000WV has been booted up successfully (see
Turn AD7000W on' on page 7).

1 Press the WPS button on your home Wi-Fi
router.

2 Shortly after step 1, press Wi-Fi SETUP on
the back of AD7000WV.
L The Wi-Fi SETUP indicator blinks red,
yellow and green alternately.

9 Within 2 minutes, the WI-FI SETUP
indicator stops blinking and stays green,
and the unit beeps.



& AD7000W is connected to your home The Wi-Fi enabled device can be an iPod touch/
Wi-Fi network successfully. iPhone/iPad or a Wi-Fi enabled PC/Mac.

Follow the sequence below for connection of
AD7000W to a non-WPS Wi-Fi router:

1 Collect settings of your home Wi-Fi router
and write down on paper for use during
AD7000W Wi-Fi setup (see ‘Collect
settings of your home Wi-Fi router’ on
nage 11).

2 Switch AD7000W to Assisted Wi-Fi Setup
mMode (see ‘Switch AD7000W to Assisted
Wi-Fi Setup mode’ on page 12).

A new Wi-Fi network created by

( @ =] G =

S = = = = AD7000W will appear, with the
network name (SSID) of Philips Fidelio
AirPlay.
E - 3 Comnect your Wi-Fi enabled device to the
'P newly created Wi-Fi network temporarily
* For some Wi-Fi routers, you may need to hold the (see ‘Connect your Wi-Fi enabled device to
WPS button for Wi-Fi connection or enable the WPS the newly created Wi-Fi network’ on page
PBC function from the router configuration pages. See 1)
the user manuals of the specific routers for detalils. -
* If the Wi-Fi SETUP indicator on AD7000W blinks 4 Qpen the built-in web page of AD7000W

yellow, it means that the Wi-Fi connection has failed.

Please wait for 2 minutes and try again. If the problem with the Internet Browser of )/OUFWI—FI

remains, iry to set up the Wi-Fi connection manually enabled device (see ‘Open the built-in web
(see ‘Scenario 2: Connect to a non-WPS router’ on nage of AD7000W' on page 14).
page 11). ~ ) - .
* If the Wi-Fi connection fails again, press and hold O on 5 \,hange the internal Wi-Fi settings of
the back of AD7000WV to reset it, and then try again. AD7000W based on the settings you
wrote on paper at step 1 (see ‘Change the
internal Wi-Fi settings of AD7000W' on
nage 15).
Scenario 2: Connect to a 6 Restore your Wi-Fi enabled device back

to your existing home Wi-Fi settings (see
non-WPS router ‘Restore your Wi-Fi enabled device back to

your existing home Wi-Fi setting’ on page
E Note 1€).

* You can also follow the procedures below to connect
AD7000W to a WPS router manually.

Collect settings of your home Wi-Fi
router

To connect AD7000W to a Wi-Fi router E Note
manually, you need access to AD7000W's

built-in configuration web page for change of
its internal Wi-Fi settings. To do so, you need a
Wi-Fi enabled device with an Internet browser
for temporary Wi-Fi connection to AD7000WV.

* Always consult the user manual of your home Wi-Fi
router for detailed instructions.
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Connect your Wi-Fi enabled device to
your existing home Wi-Fi network.

Launch the Internet browser (for example,
Apple Safari or Microsoft Internet
Explorer) on your Wi-Fi enabled device.
Open the configuration page of your
home Wi-Fi router.

Find the Wi-Fi settings tab and write down
the following information on paper:

@ Network name (SSID)

Wi-Fi security mode (usually WEP
WPA or WPA?2 if enabled)

(© Wi-Fi password (if Wi-Fi security is
enabled)

@ DHCP mode (enabled or disabled)

@ Static IP address settings (if DHCP
mode is disabled)

Switch AD7000WV to Assisted Wi-Fi
Setup mode

Note

¢ Before you press any button on AD7000W, make sure

that AD7000WV has been booted up successfully (see

Turn AD7000W on' on page 7).

12

MPLINK  WI-FI

@ SETUP

EN

Press and hold Wi-Fi SETUP on the back

of AD7000WV for more than 5 seconds.

L» The Wi-Fi SETUP indicator blinks
green and yellow alternately.

A new Wi-Fi network created by
AD7000W will appear, with the
network name (SSID) of Philips Fidelio
AirPlay.

> [t may take up to 45 seconds for
successful creation of this new Wi-Fi
network.

After you finish manual Wi-Fi setup for AD7000V,
the new Wi-Fi network created by AD7000W will
disappear.

If you fail to enter Assisted Wi-Fi Setup mode, power
off AD7000W and power on it, then try again after
successful boot-up.

Make sure that there are no other Philips AirPlay-
enabled devices in Assisted Wi-Fi Setup mode at the
same time. Multiple Wi-Fi networks created this way
may interfere with each other.

Connect your Wi-Fi enabled device to
the newly created Wi-Fi network

The new Wi-Fi network created by AD7000W
only allows access of one Wi-Fi enabled device.
To avoid interference from any other Wi-Fi
devices, you are recommended to temporarily
disable the Wi-Fi function on your other Wi-Fi
devices.

Option 1: Use your iPod touch/iPhone/iPad

1

Select Settings -> Wi-Fi on your iPod
touch/iPhone/iPad.




- 3 Wait until successful Wi-Fi connection on
Setti ngs your iPod touch/iPhone/iPad.
> = is displayed at the upper left corner
of your iPod touch/iPhone/iPad.

<
»

o0
=

w

Tip

* If Philips Fidelio AirPlay is not in the list, try to scan the
available Wi-Fi networks again.

Use your Wi-Fi enabled PC/Mac

Note

See the user manual of your PC/Mac for how to

ﬂ Br’lghtmss connect your PC/Mac to a Wi-Fi network.
During Wi-Fi network connection, do not connect any

network cable to your PC/Mac.
ﬁ Wallpaper

pen the Wi-Fi setup tool or contro
1 Open the Wi-Fi | !
= G I N panel on your PC/Mac.

| enera

2 Scan the available Wi-Fi networks.

2 Select Philips Fidelio AirPlay from the list
of available networks.

settings ~ Wi-Fi Networks

Searchin for sivsiess rbemerks inrange. .

e

3 Select Philips Fidelio AirPlay from the list
of available networks.
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mﬂm s Choose a wireless network

< Setm o versless e (g emes
o 2P e s st i

|

i s st i
Fatmring

1 Securty snabled s v, will

Plabps Hdebs Auplay

T Tange the order of
sretarmd et

o
¥ Targe atvnced
.

((g) 4 et
r i aty-deablad st atvatek (PR nﬂ]
gy **

4 Wait until successful Wi-Fi connection on
your PC/Mac.

(ei:} —— &
A Securty-snabled sreless neteort. ‘
«i:l s
£ Seant et v et will

(Tl .
¢ Securiy-enabied wedess moba. il

Lop ==

Tip

¢ If Philips Fidelio AirPlay is not in the list, try to scan the
available Wi-Fi networks again.

Open the built-in web page of
AD7000W

1 Launch Apple Safari browser or any other
Internet browser on your Wi-Fi enabled
device.

2 Type in 192.168.1.1 at the browser
address bar and confirm.

5 The AD7000W configuration
web page is displayed.

14 EN

Philips Fidelio

Welcome to Philips FidelR

stepahemmmnnec.l

de\noe name change
Philips Fidelio device name:

Philps_Fidelio 2338FA

Please select your wireless network and enter
your network password if applicable. For
advanced network setup, please click
Advanced; Click Apply to connect your wireless

speaker to your network.
Please select your Wi-Fi network: | Setect option [
| = mMm D

If you use Safari on your Wi-Fi enabled PC/
Mac, you can also select ‘Philips_Fidelio XXX’
from the Bonjour pull-down list to enter the
AD7000W configuration web page directly.

1 Click # -> Preferences.
% The Bookmarks menu is displayed.

=

wewn | NEERR

Frilips Fidelio

e :——-..J Lkt
Customize Taolbar
P i Hide Menu Bar
Hide Bookmarks Bar ~ Chrl+Shift+8
Hide Tab Biar Chri+ShiFt+T
Hide Status Bar Cirtf
History ChritH
Downloads Chri+Alt+L
Brivate Browsing
Reset Safari
Block Pop-Lp Windows  Cerk+Shift+K
——
e
Help F1
Report Bugs ta Apple
Safari Extensions Gallery
About Safari




2 Tick Include Bonjour for Bookmarks bar.

182.168.1.1

[v]

Pl Fidelo ‘

w2 Q 3G Welcome to Philps Fidello setup page. Folow the
| Tibe REL MBS Seculy [dtateons Advinced #laps below 10 connect your wireless speaker lo your
wirchess network

You can keep the default device name ar
modily the device name by modifying the taxt
in the bext box. Click Apply o procesd with

Fhilips Fidelo deuics nama; Phelen. Fetuis 1050

3 Select Philips_Fidelio XXX’ from the =

Bonjour pull-down list shown at the “Hmmmmmmmmmr
bookmarks bar. e
> The AD7000W configuration web sk it

page is displayed. Pinass seocs your U Finotworkc st
4 2?2 m O

IE-;;IFF.M 7F 77::”_ ﬁ — *  Follow the on-screen instructions to

Wt parstier | change and confirm the internal Wi-Fi
al . settings of AD7000W.
2 Bnﬁ:;r t' B }-:mple e e > After a while, the indicator on the back
u i of AD7000WV stops blinking and stays
s —— green, and the unit beeps.

> AD7000W is connected to your
existing home Wi-Fi network
successfully.

Change the internal Wi-Fi settings of E Note
AD7000W * If the WI-FI SETUP indicator on AD7000W does not
stay green steadily, it means that the Wi-Fi connection
On the AD7000W conﬂguration web page, has failed. Please power off both your Wi-Fi router
. - . and AD7000W and then power on them again to see
you can change the internal Wi-Fi settings of whether AD7000W can be connected to your home
AD7000W for connection of AD7000W to Wi-Fi network. If the problem remains, try the above
your existing home Wi-Fi network. procedures again.
¢ After you finish the above changes or power-off and
power-on of AD7000WV, the new Wi-Fi network
Note created by AD7000W will disappear.

¢ Make sure that the settings on the configuration web

page match your home Wi-Fi network settings that you E Tip
wrote on paper.

* If you like, you can change the name of your AD7000W
in Advanced settings -> AirPlay Device Name on the
AD7000W configuration web page.This is helpful when
you have multiple Philips AirPlay-enabled devices in
your house and you need to distinguish between them.

* If you want to enter the network name (SSID) manually
(for example, if you want to hide your SSID), go to
Advanced settings -> CONFIGURE MANUALLY on
the AD7000W configuration web page.
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Restore your Wi-Fi enabled device 2 Select your network name (SSID) from the
back to your existing home Wi-Fi list of available wireless networks.

setting

settings ~ Wi-Fi Networks

Note

* Make sure that the settings at steps 2 to 3 below match
your home Wi-Fi network settings you wrote on paper.

1 select Settings -> Wi-Fi on your iPod
touch/iPhone/iPad.
*  Or open the list of available Wi-Fi
networks on your PC/Mac.

Settings

3 Enter the network key if required.

4 Wait until successful Wi-Fi connection to
your home Wi-Fi network.
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5 PI ay 3 Select Philips_Fidelio XXXX (or user

customized name) from the AirPlay list.

Stream audio from your
iTunes music library to
AD7000W

* Make sure that your iTunes host device is connected
to the same Wi-Fi network as AD7000W.Your iTunes
device can be an iPod touch/iPhone/iPad installed with
iOS 4.3 (or later) or a Wi-Fi enabled PC/Mac installed
with iTunes 10 (or later).

Cancel

Stream from your iPod touch/iPhone/

iPad 4 Select a media file and start play.
1 Launch the iPod application on your iPod > After a while, you will hear music from
touch/iPhone/iPad. AD7000WV.

2 Tap on the AirPlay icon.

@ "Symphon'yNo..S 5che

- 4« I wI

A———

* If you fail to hear music after successful setup, do one of
the following on your iPod touch/iPhone/iPad:

¢ (1) Disconnect and then re-connect to the same Wi-Fi

router again;

(2) Close all applications running at the background;

* (3) Power off and then power on your iPod touch/
iPhone/iPad again.
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Stream from your PC/Mac

1 Launch iTunes 10 (or a later version) on
your PC/Mac.

2 Clickthe AirPlay icon on the window.

3 Select Philips_Fidelio_AirPlay XXXX (or
user customized name) from the AirPlay
list.

v [ My Computer

[=—

4 Select a media file and start play.
L After a while, you will hear music from
AD7000WV.

[
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Tip

* When you stream audio from your iTunes music library
on a PC/Mac, you can select more than one AirPlay-
enabled devices (if available) at step 3 to stream music
to all of them at the same time.

¢ If you are using an earlier version of iTunes, the AirPlay
icon may be £ instead of [al.

Control play

You can select different play options from either
your iTunes host device or AD7000WV.

Note

* Make sure that you have successfully streamed audio
from your iTunes music library to AD7000WV.

*  To pause or resume play, press P Il
* o adjust volume, press +/- repeatedly.

Tip

¢ If you are streaming music from a PC/Mac, to control
music play from AD7000WV, remember to tick Allow
iTunes audio control from remote speakers in Edit ->
Preferences -> Devices on iTunes.

Use advanced sound settings

If your iTunes host device is an iPod touch/
iPhone/iPad:

For advanced sound settings and additional
features, you can use your iPod touch/iPhone/
iPad to download the Philips Fidelio application
from Apple App Store. It is a free application
from Philips.

If your iTunes host device is a Wi-Fi enabled
PC/Mac:

For advanced sound settings, you can use the
equalizer available on iTunes directly (View ->
Show Equalizer).

Tip

* See the iTunes help documentation for more details.




Play/charge your iPod/iPhone/
iPad through USB socket

* The USB socket is only compatible with iPod/iPhone/
iPad.

You can play or charge your iPod/iPhone/iPad
through the USB socket with an Apple USB
cable (not supplied).

If you have stopped audio streaming by AirPlay,
after successful USB connection, the unit
switches to the USB source automatically.

/ MPELINK  WIFI A\
\ DCIN@ 4} @ SETUP !

*  Connect an Apple USB cable (not

supplied) to:

*  the USB < socket on the back of
AD7000W.

*  the dock connector on your iPod/
iPhone/iPad.

Compatible iPod/iPhone/iPad

The USB socket supports play and charge of
the following iPod, iPhone, and iPad models.
* iPad2

* iPad

e iPhone 4

*  iPhone 3GS

*  iPhone 3G

*  iPhone

*  iPod classic

* iPod 5G

* iPod 4G

* iPod nano (2nd, 3rd, 4th, 5th, and 6th
generation)

*  iPod touch (1st, 2nd, 3rd, and 4th
generation)

Play from an external device

You can also listen to an external audio player
through the unit.

If you have stopped both audio streaming
by AirPlay and play through the USB socket,
the unit switches to the MP3 link source
automatically.

N\

-
0= GO |
~

»  Connect the supplied MP3 link cable to:
* the DC IN socket on the back of the
unit.
* the headphone jack on an external
audio player.
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6 Update Update from the
firmware configuration page

1N Warning

* Always connect your AD7000W to AC power for
Note firmware upgrade. Never power off your AD7000W
during firmware upgrade.

* You can only update the firmware from a PC/Mac.

Note

¢ To use an Internet browser other than Apple Safari
on your PC/Mac, remember to go to the Wi-Fi router
configuration page and write down the IP address of

Download the update file

-2 o 1 your AD7000WV. See the user manual of your Wi-Fi
ae SRR router for how to find the IP addresses of devices
Lo o | www.philips.com/support | l" e I connected to the Wi-Fi router.

1 2ower on AD7000W (see “Turn

0 _ 5'5 SIS & AD7000W on' on page 3).

SRRy LX0XX - > It takes about 35 seconds for the unit
to boot up. During boot-up, the WI-FI
SETUP indicator on the back of the

______ s e unit blinks green quickly.

]
-

> After boot-up, you can hear a beep
e il and the WI-FI SETUP indicator

| turns to green steadily. AD7000WV is
connected to the last configured Wi-Fi
(3) % XXXX. zip network automatically.

2 Make sure that AD7000W and your PC/
Mac are connected to the same Wi-Fi
router.

1 on your PC/Mac, go to www.philips.com/

support. 3
2 Enter the model number to find the latest

firmware upgrade file available.

Open Apple Safari on your PC/Mac, then

select ‘Philips_Fidelio XXX’ from the

Bonjour pull-down list.

3 Save the upgrade file to your hard drive. D Or open any other Internet browser

on your PC/Mac, then type in the IP

address of AD7000W (available on

the Wi-Fi router configuration page)

at the address bar.

> The AD7000W configuration
web page is displayed.
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4

G

Follow the on-screen instructions to
complete the firmware update.

In case the firmware update fails, you can try the above
procedures again.

After successful firmware update, if there is any
problem with the Wi-Fi connection, press and hold &
on AD7000W for more than 5 seconds to reset the
device, and then try to set up the Wi-Fi network for
AD7000WV agair (see ‘Connect to your home Wi-Fi
network for AirPlay’ on page 1C).

EN
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/ Product
information

Note

General information

AC power

Input: 100 - 240

¢ Product information is subject to change without prior

notice.

Specifications

Amplifier

Rated Output Power

2 X 5W RMS

V~,50/60 Hz
TAN2A
Output: 12V =
30A

Operation Power 25W

Consumption

Power Consumption in <05W

Standby Mode

Dimensions

- Main Unit (L xW x H) 298 x 98 x
168 mm

Weight

- With Packing 2.02 kg

- Main Unit 1.36 kg

Frequency Response

63 Hz - 18 kHz, +3 dB

Signal to Noise Ratio

>90dB

MP3 Link

600 mV RMS 20 kohm

Speakers

Speaker Impedance 8 ohm

Speaker Driver 66 mm full range
Sensitivity 82 dB/m/W
Wireless

Wireless 802.11b/g

standard

Wireless WEP (64 or 128 bit),
security WPA/WPA?2 (8-63 characters)
Frequency 2412 - 2462 MHz (CH1-
range CH11) (for /79,137,155, 197)

2412 - 2472 MHz (CH1-
CH13) (for /12,10, /05)

PBC (one Yes
button push)
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8 Troubleshooting

'!‘ Warning

* Never remove the casing of this apparatus.

To keep the warranty valid, never try to repair
the system yourself.

If you encounter problems when using this
apparatus, check the following points before
requesting service. If the problem remains
unsolved, go to the Philips web site (www.
philips.com/welcome). When you contact
Philips, ensure that the apparatus is nearby
and the model number and serial number are
available.

No power

*  Make sure that the AC power plug of the
device is connected properly.

e Make sure that there is power at the AC
outlet.

No sound

*  Adjust the volume.

e Check the Wi-Fi network connection.
Set up the network again if needec (see
‘Connect to your home Wi-Fi network for
AirPlay’ on page 10).

No response from the unit

*  Press and hold ® on AD7000W for more
than 5 seconds to reset the device. Then
set up the Wi-Fi network for AD7000W
again (see ‘Connect to your home Wi-Fi
network for AirPlay’ on page 1C).

»  Disconnect and reconnect the AC power
plug, and then switch on the device again.

Wi-Fi network connection failed

e Check if your Wi-Fi router is Wi-Fi
802.11b/g certified. This device is only
compatible with Wi-Fi 802.11b/g certified
routers.

e If your Wi-Fi router is Wi-Fi 802.11n
certified, make sure to enable the
802.11b/g mode. AD7000W does not
support connection to routers with
802.11n only.

*  This device does not support the WPS-
PIN method.

e If your Wi-Fi router supports WPS and the
WPS-PBC method but fails to connect to
AD7000W, try the manual Wi-Fi setup
methoc (see ‘Scenario 2: Connect to a
non-WPS router’ on page 11).

*  Enable SSID broadcast on the Wi-Fi router.

*  Keep away from potential sources of
interference which may affect Wi-Fi signal,
such as microwave ovens.

*  If you fail to use your PC for Wi-Fi network
setup, check whether your PC is using a
Wi-Fi network.You cannot use Ethernet
connection for AirPlay network setup.

e Make sure that the SSID name of your
home router consists of alphanumeric
characters, with no space or special
characters like %/#/* inserted.

*  If you choose to rename the AirPlay device
‘Philips_Fidelio XXXX'in the setting
menu, do not use special characters or
symbols.

*  Forsome new types of Wi-Fi routers, a
network name (SSID) may be created
automatically when you use WPS for
connection. Always change the default
network name (SSID) to a simple one that
consists of alphanumerical characters, and
also change the Wi-Fi security mode to
secure your network.
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Occasional breaking of AirPlay music streaming

Do one or all of the following:

* Move AD7000WV closer to your Wi-Fi router:

*  Remove any obstacles between AD7000W
and your Wi-Fi router.

*  Avoid using Wi-Fi channel which is
overlapped by the nearby Wi-Fi network.

*  Check if your network speed is fast enough
(in cases where multiple devices share the
same router, the AirPlay performance may
be affected). Turn off the other devices
connected to your home router.

*  Enable the Quality of Service (QoS)
option (if available on the Wi-Fi router).

*  Turn off other Wi-Fi routers.

No AirPlay icon on my iTunes host device

*  Make sure that AD7000WV is already
connected to your home Wi-Fi network.

*  Before you open iTunes, make sure that
you have enabled Bonjour service in
your PC.Take Windows XP for example:
to enable the service, you can click
Start->Control Panel, and double-click
Administrative Tools-> Services->Bonjour
Service, then click Start followed by OK
on the pop-up menu.

e Ifthe problem remains, try to restart
AD7000W.

AirPlay connection failed with Mac or PC

*  Temporarily disable the firewall and
security software to see whether it blocks
the ports that AirPlay uses to stream
content. See the help documentation of
your firewall and security software on how
to unblock the ports used by AirPlay.

*  When you use iPod Touch/iPhone/iPad/
Mac/PC for AirPlay, if the music play breaks
or stops, try to restart your iPod Touch/
iPhone/iPad, iTunes or AD7000WV.

*  Video streaming or FTP downloads may
overload your router and therefore may
cause interruptions during AirPlay music
play. Try to reduce the load of your router.
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